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Workshop 1: Starting with Flutter

What is Flutter

In the simplest terms, Flutter is a software development toolkit from Google for building
cross-platform apps. Flutter apps consist of a series of packages, plugins and widgets — but
that’s not all. Flutter is a process, a philosophy and a community as well.

Dart

Multiplatform  Hot Reload  Open Source Language

Widgets

Flutter has a modular, layered architecture. This allows you to write your application logic
once and have consistent behavior across platforms, even though the underlying engine
code differs depending on the platform

Flutter Framework Plugins

Dart - reactive framework High-level
with platform, layout, features
foundation libraries

tngine

C++ - library to support primitives, rasterization, i/o,
Dart runtime, plugin architecture

Embedder

Platform Specific - turns code into app or library

The Flutter architecture consists of three main layers:
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1. The Framework layer is written in Dart and contains the high-level libraries that you’ll use
directly to build apps. This includes the Ul theme, widgets, layout and animations, gestures and
foundational building blocks. Alongside the main Flutter framework are plugins: high-level
features like JSON serialization, geolocation, camera access, in-app payments and so on. This
plugin-based architecture lets you include only the features your app needs.

2. The Engine layer contains the core C++ libraries that make up the primitives that support
Flutter apps. The engine implements the low-level primitives of the Flutter API, such as 1/0,
graphics, text layout, accessibility, the plugin architecture and the Dart runtime. The engine is
also responsible for rasterizing Flutter scenes for fast rendering onscreen.

3. The Embedder is different for each target platform and handles packaging the code as a
stand-alone app or embedded module

In order to start with Flutter, we need a few tools:

e A PCwith arecent Windows version, or a Mac with a recent version of the macOS
or Linux operating system. we can also use a Chrome OS machine, with a few
tweaks.

An Android/iOS setup.

The Flutter SDK. It's free, light, and open source.

Physical device/emulator/simulator

Android Studio/Intelli] IDEA or Visual Studio Code

1- Install Android Studio

2- Install Android SDK in (for example) D:\Android\Sdk
3- Install Flutter

4- Configure Flutter\bin in user environnement variable
5- Execute Flutter doctor

C:\Users\user>flutter doctor
Doctor summary (to see all details, run flutter doctor -v):
Flutter (channel stable, 2.5.1, on Microsoft Windows [version 1@.@.19@42.1237], locale fr-fFR)
[!] Android toolchain - develop for Android devices (Android SDK version 3@.8.2)
| Some Android licenses not accepted. To resolve this, run: flutter doctor --android-licenses
Chrome - develop for the web
Android Studio (version 2020.3)
Intelli] IDEA Ultimate Edition (version 2020.3)
Connected device (2 available)

| Doctor found issues in 1 category.

C:\Users\user>

You may accept all the Android license agreements. You can do this quickly from
the terminal line with this command:
flutter doctor --android-licenses
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rs\user>flutter doctor
or summary (to see all details, run flutter doctor -v):
Flutter nnel stable, 2.5.1, on Microsoft Win [version 10.0.19042.1237], locale fr-FR)
Android chain - develop for Android devices (Android SDK version 30.0.2)

Chrome - develop for the web

Android Studio (version 2020.3)

Intelli]l IDEA Ultimate Edition (version 2020.3)
Connected device (2 available)

If the sdk is not configurated, execute the next commande
flutter config --D:\Android\ Sdk

6- If Android SDK Command-line Tools is not configurated
Install then Android SDK Command-line Tools in Android Studio:

Preferences > Appearance & Behavior > System Settings > Android SDK > SDK Tools >
Android SDK Command-line Tools (latest)

7- In some cases you need to add the following lines to your path variable

C:\Program Files\Git\bin

C:\Program Files\Git\cmd

C:\Windows\System32
C:\Windows\System32\WindowsPowerShell\v1.0

Be sure you have installed git framework

8- Create the first application my_first_app

flutter create my_first_app
Execute then

flutter devices

9- Itis sometimes recommended to install an emulator in Android studio
flutter run

10-To run your app on one of the available devices, type the following command:

flutter run -d [your_device_name]
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Flutter Demo Home Page

You have pushed the button this many times:

0

11-It will be necessary to install the flutter plugins and configure flutter in Android
studio

File->Settings->Language & Framework->Flutter
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Settings
Q Languages & Frameworks * Flutter For current project
Appearance & Behavior AL
fiEes misvan Flutter SDK path: D:\flutter
Passwords
Version: s .
Android SDK Flutter 2.5.1 » channel stable « https://github.com/flutter/flutter.gi
Memory Settings General
File Colors Report usage information to Google Analytics WWW.J0O
Scopes Enable verbose logging
Notifications i
App Execution
D Perform hot reload on save
Path Variables i
Show structured errors for Flutter framework issues
Keymap
Include all stack traces
> Editor
Open Flutter Inspector view on app launch
Plugins
> Version Control Editor
.4 Show Ul Guides for build methods
> Build, Execution, Deployment .
v . .
R T e . Show closing labels in Dart source code
> Schemas and DTDs Format code on save
Dart Organize imports on save
Experiments
S Kotlin Try out features still under development (a restart may be required)
Plugins Show Ul Guides for build methods
> Version Control Show closing labels in Dart source code
2 Build, Execution, Deployment Format code on save

~ Languages & Frameworks Organize imports on save

> Schemas and DTDs )
Experiments

Dart Try out features still under development (a restart may be reg

Enable code completion, navigation, etc. for Java / Kotlin

2 Kotlin

Enable Hot Ul {an early preview of property editing in th

12-To speed up the tests, it is wise to consider the default browser to run these tests
In an Android Studio terminal select chrome as an emulator when executing the
Flutter run command



Workshop Framework cross-platform Workshop 1: Starting with Flutter project

&w Structure

W Favarites

Terminal:  Local +

Application finished.

E:\TP_JEE\Etudiant\flutter_apps\Flutter-Projects-master\ch_03>flutter devices
2 connected devices:

Chrome (web) - chrome - web-javascript +« Google Chrome 93.0.4577.82
Edge (web) + edge « web-javascript « Microsoft Edge 93.0.961.52

E:\TP_JEE\Etudiant\flutter_apps\Flutter—Projects—master\ch_03>l

i= TODO © Problems B Terminal ‘@ Dart Analysis

Install Android SDK in Visual Studio code

The simplest way to set up the prerequisites is to download "Android Studio for Windows",
run it, and follow the "Setup Wizard" it will present to guide you through installing the
Android SDK. After that, the Android SDK will be available in %9APPDATA%/Android/SDK,
where vscode will pick it up automatically.

In vscode to lunch an emulator Do Ctrl + Shift + P
Then type Flutter:launch emulator

[] flutter emulator mobile
E Chrome web
= Edge web

[> Start Pixel 4 APl 30 mobile emulator
[> Start Pixel 4 APl 30 mobile emulator (cold boot)
—~+ Create Android emulator

You can see the bottom menu in VScode, click on this button and you will able to see all
the available devices.

on sdk gphone x86 64 is available at:
51874/4TelNeiUKbc=/

Dart Dart Deviools Flutter: 25.3 flutter emulator (android-x64 emulator) kite: unsupported

To optimize time execution, you can change the path to android\avd
in my Android Studio

1- Open the directory: C:\Users\Username\. android\avd , you will find the directory
named with your AVD and a. ini file.

2- move the file .avd to your desirable path, then change the path variable in the . ini
file to the new location.
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https://stackoverflow.com/questions/40501341/how-can-i-change-the-path-to-android-avd-in-my-android-studio
https://stackoverflow.com/questions/40501341/how-can-i-change-the-path-to-android-avd-in-my-android-studio
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3- start the Android studio, you will find that the AVD can work properly.

For example in C:\Users\user\.android\avd we retain the file Pixel_3_API_24.ini witch
contain :

avd.ini.encoding=UTF-8
path=D:\Android\avd\Pixel_3_API_24.avd
path.rel=avd\Pixel_3_API_24.avd
target=android-24

To avoid the next message during launch of an AVD, go to

File -> Project Structure -> Project Settings -> Project, and select the Project SDK, which is
set to [No SDK] by default.

AVD Manager X

o Unable to locate adb

Project Structure

Project name:

. . ch_02
Project Settings
—— Project SDK:
Modules This 5DK is default for all project modules.
L A module specific SDK can be configured for each of the modules as reguired.
Libraries
B m <No SDK= b Edit
Artifacts B &g <NoSDK=
Platform Settings T Android APl 28 Platform version 1.8.0 281
2 modules as required.
SDKs 4 Android API 29 Platform version 1.8.0_281

Global Libraries Android API 30 Platform version 1.8.0_ 281 M

Android API 31 Platform version 1.8.0_281

Problems M= 18 version 1.8.0_281

« Android Studio default JDK version 1.8.0_281 th.
production code and te

= T = |

The files that Flutter generates when you build a project should look like this:

The main folders in your projects are listed here:
android

build

10S

lib

test
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V% tp2 EATPER\Etudiant\flutter apps\tp2
N ° dart ool . The android and ios folders contain
; ; dea‘ the platform shell projects that host our
y ) Flutter code. You can open the
3  android Runner.xcworkspace file in Xcode or the
# H gradle android folder in Android Studio, and they
v W app should run just like normal native apps.
> M sic Any  platform-specific  code  or
build.gradle configurations should be placed in these
} gradle folders.
@ .gitignore
build.gradle - The build folder calls all the artifacts
A, gradle.properties that are generated when you compile your
gradlew app.
= gradlew.bat

- The lib folder is the heart and soul
(d&me) of your Flutter app. This is where
you will put all your Dart code. When a
project is created for the first time, there is

;1 local.properties
settings.gradle
m tp2_android.iml

> W build only one file in this directory: main.dart.
e . ios
" Flutter - The next file, pubspec.yaml, holds
) Runner the configuration for your app. This
> Runner.xcodeproj configuration file uses a markup language
> Runner.xcworkspace called YAML Ain't Markup Language
% .gitignare (YAML), which you can read more about
v B lib at https://yaml.org. In the pubspec.yaml
% maindart file, you'll declare your app's name, version
> D test number, dependencies, and assets.
2 i:ili;i pubspec.lock is a file that gets generated
L based on the results of your pubspec.yami
= .packages file. It can be added to your Git repository,
. analysis_options.yaml but it shouldn't be edited.
= pubspeclock
e PUbspecyaml - Finally, the last folder is test. Here,

you can put your unit and widget tests,
which are also just Dart code. As your app expands, automated testing will become an
increasingly important technique to ensure the stability of your project.

13- Test : Update the primary swatch to green, as shown in the following code snippet, and
hit Save:

primarySwatch: Colors.green

14- Now consider the icon button to decrement the value to display
In addition, display the message "Hello™ with this value
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G

Flutter Demo Home Page

You have pushed the button this many times:
Hello -2

-2

You may insert the following code

class _MyHomePageState extends State<MyHomePage> with
WidgetsBindingObserver {
int counter = 0;

String message = "Hello";

@override

void didChangeAppLifecycleState (AppLifecycleState state) {
print ('state = S$Sstate');

}

@override
vold initState() {
super.initState();
WidgetsBinding. instance.addObserver (this);

}

void incrementCounter () {
setState (() {
_counter--;
message = "Hello ${ counter}";

)i
}

choose the type of icon exposure minus 1 for the button at the bottom

child: Icon(Icons.exposure minus 1),

2" application

1- Create a new flutter application named “navigation”. The aim is to navigate
between two screens via a RoutePages class
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import 'package:flutter/material.dart';

import 'package:sec5 navigation/Screenl.dart';

’

import 'package:sec5 navigation/routes.dart';

void main () {
runApp (MyApp () ) ;
}

class MyApp extends StatefulWidget {
@override
_MyAppState createState() => MyAppState();
}

class MyAppState extends State<MyApp> {
@override
Widget build(BuildContext context) {
return MaterialApp (
routes: PageRoutes () .routeMaker(),
initialRoute: PageRoutes.screenl page,
) ;

1036 @ @ &

<
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2- Create routes.dart to configurate rourtes

import 'package:flutter/material.dart';
import 'package:navigation/Screenl.dart';
import 'package:navigation/Screen2.dart';

class PageRoutes {
static String screenl page = "screenl";

static String screenZ page = "screen2";

Map<String, WidgetBuilder> routeMaker () {

return {
screenl page: (context) => Screenl(),
screenZ page: (context) => Screen2(),

}i

3- Screenl and screen? classes are represented respectively in screenl.dart and

screen2.dart

import 'package:flutter/material.dart';
import 'package:navigation/routes.dart';

class Screenl extends StatefulWidget
@override

10
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_ScreenlState createState() => ScreenlState();

}

class _ScreenlState extends State<Screenl> ({
@Qoverride
Widget build(BuildContext context) {
return Scaffold(
backgroundColor: Colors.greenAccent,
body: GestureDetector (
behavior: HitTestBehavior.opaque,
onTap: () {
// Navigator.of (context)
// .pushReplacement (MaterialPageRoute (builder: (context)
// return Screen2();
/7 F))
Navigator.of (context) .pushNamed (PageRoutes.screen2 page);
b
child: Column (
mainAxisAlignment: MainAxisAlignment.center,
crossAxisAlignment: CrossAxisAlignment.center,
children: [
Center (
child: Text(
"Screenl",
style: TextStyle(
color: Colors.white,
fontSize: 22.0,
fontWeight: FontWeight.bold),

screen?.dart

import 'package:flutter/material.dart';

class Screen?2 extends StatefulWidget
@override
_Screen2State createState() => ScreenZstate();

}

class Screen2State extends State<Screen2> ({
Future<bool> onBack () async {
print ("Back button clicked");
return true;

}

@override
Widget build(BuildContext context) {
return WillPopScope (
onWillPop: onBack,
child: Scaffold(
backgroundColor: Colors.lime,
appBar: AppBar (
backgroundColor: Colors.green,

{

Workshop 1: Starting with Flutter project

11
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leading: IconButton (
onPressed: () {
Navigator.of (context) .pop () ;
b
icon: Tcon(
Icons.arrow back ios,
)
)y
)y
body: Column (
mainAxisAlignment: MainAxisAlignment.center,
crossAxisAlignment: CrossAxisAlignment.center,
children: [
Center (
child: Text (
"Screen2",
style: TextStyle(
color: Colors.white,
fontSize: 22.0,
fontWeight: FontWeight.bold),

3 application

1- Create new Flutter application named “tp1”

2- Open main.dart and delete everything! Then, type the following code into the editor:

void main () => runApp (StaticRpp());

class StaticApp extends StatelessWidget {
@override
Widget build(BuildContext context) {
return MaterialApp (
home: ImmutableWidget (),

) ;

3- Import the material.dart
4- type the following code to create a new stateless widget in a new dart file named
immutable_widget.dart

import 'package:flutter/material.dart';

class ImmutableWidget extends StatelessWidget {
@override
Widget build(BuildContext context) {
return Container (
color: Colors.green,
child: Padding(
padding: Edgelnsets.all (40),
child: Container(

12
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color: Colors.purpleAccent,
child: Padding(
padding: const Edgelnsets.all (50.0),
child: Container(
color: Colors.cyanAccent,

6- Using a Scaffold :
Scaffold provides a basic structure of a screen.

We will be using the Scaffold widget to add an AppBar to the top of the screen and a slide-out
drawer that we can pull from the left.

a. Inbasic_screen.dart, type stless to create a new stateless widget and name that widget
BasicScreen. Don't forget to import the material library as well

import 'package:flutter/material.dart';
import './immutable widget.dart';

class BasicScreen extends StatelessWidget {
@override
Widget build(BuildContext context) {
return Scaffold(
appBar: AppBar (
backgroundColor: Colors.indigo,
title: Text ('Welcome to Flutter'),
actions: <Widget>[
Padding (
padding: const Edgelnsets.all(10.0),
child: Tcon(Icons.edit),

1,
)
body: Center (
child: AspectRatio(
aspectRatio: 1.0,
child: ImmutableWidget (),

13
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b. Now, in main.dart, replace ImmutableWidget with BasicScreen. Hit the save button to
hot reload and your simulator screen should be completely white:

import 'package:flutter/material.dart';

import './basic screen.dart';

void main () => runApp(StaticApp()):;

class StaticApp extends StatelessWidget {
@override
Widget build(BuildContext context) {
return MaterialApp (
home: BasicScreen(),

) ;

c. Finally, let's add a drawer to the app. Add this code to Scaffold, just after body:

drawer: Drawer (
child: Container (
color: Colors.lightBlue,
child: Center(
child: Text ("I'm a Drawer!"),

),
),

The final app should now have a hamburger icon in AppBar. If you press it, the drawer will
be shown:

Welcome to Flutter

14
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